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Introduccion

Hemos elegido para este proyecto analizar esta suite debido a que usa una licencia LGPL,
es de codigo abierto, y permite la participacidén activa de la comunidad en el desarrollo del
mismo.

A continuacion resumimos los aspectos fundamentales para entender el resto del
documento:

e En cuanto a la gestion del codigo fuente LibreOffice trabaja con Git, lo que nos va a
facilitar su seguimiento.

e En la Gestion de la construccion, LibreOffice es multiplataforma. Vamos a realizarlo en
Linux por que la mayoria de los desarrolladores trabajan en Linux y consideramos que
habria més documentacion actualizada bajo el sistema operativo Linux.

e Como entregables LibreOffice nos brinda el software como tal, el cédigo fuente en C++,
manuales de usuario y al menos 6 productos que son Writer, Calc, Impress, Draw, Base
y Math.

e LibreOffice se despliega en escritorio y es multiplataforma, como hemos dicho
anteriormente.

e Para el reporte de bugs LibreOffice utiliza Bugzilla y listas de correo. En Bugzilla se
registran los bugs para ser resueltos, mientras que las listas de correo tienen una indole
mas informativa y de reporte.

e En cuanto a la gestion de la variabilidad, el paquete de software LibreOffice, contiene
una base comun a todo el proyecto, que gestiona varios productos sobre ella misma,
dando como resultado la suite completa del programa. De esta manera, tenemos un
nucleo de la aplicaciéon que da origen a varios productos basados en uno mismo.

e En cuanto a la integracion, LibreOffice se integra con otros sistemas de suites
ofiméticas en la nube, y ademas incluye la posibilidad de ampliacién personalizada e
individualizada a través de un sistema de extensiones, que permite adaptar
personalmente el software, y ademas se mantiene en desarrollo continuo gracias a su
naturaleza de desarrollo libre en la comunidad.

e En el desarrollo de LibreOffice se utiliza como herramienta Bugzilla, listas de correos,
Git, entornos para C++ (ninguno especificamente).

Con objeto de facilitar la busqueda de aspectos concretos del desarrollo de LibreOffice, en este
trabajo utilizaremos un formato de preguntas/respuestas.
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Gestion del cédigo fuente

LibreOffice utiliza Git para la gestion del cédigo.

: Cuanto tiempo se tarda en bajarse los archivos del codigo fuente por git ?

La descarga a través de Git, funciona a una media de 170Kb en una linea promedio de
10Mb de ancho de banda, con un tréfico en condiciones estandar y en una maquina virtual de
Ubuntu. El tamafio de datos a descargar es de X Gb, y en total, supone una totalidad de tiempo
de 1Gb.

;Podemos instalar libreOffice en cualquier ordenador c@m solo click?

No, LibreOffice gestiona en distintos paquetes su instalacion, Instalador Principal,
Interfaz de Usuario Traducida (s6lo en linux) y la Ayuda Incorporada de LibreOffice, ademas
todos estos paquetes deben instalarse en orden.

:Se pueden hacer ramas?
Si, de hecho, LibreOffice las usa para dividir sus lineas de trabajo.

¢Como se gestionan las ramas? @
LibreOffice esté estructurado en varias ramas divididas uncionalidad:
e master - principal rama de desarrollo
e libreoffice-X-Y - release branch, suited to release the X.Y product line (like
libreoffice-3-4)
e libreoffice-X-Y-Z - release branch, suited to release the concrete version (like
libreoffice-3-4-0, to release 3.4.0)
e integration/dev300_mXYZ - integration branch, to merge code from OpenOffice.org,
or elsewhere [obsolete]
o feature/NAME - topic (feature) branch, to develop a feature without changing any
other branch
e private/$GERRITUSERNAME/NAME private test branches etc.
A continuacién, los LibreOffice Master tienen la responsabilidad de hacer merge con el
repositorio principal.

;Como se hacen los merge? ;Con que frecuencia se hacen?
Los merges se hacen de las ramas individuales a las ramas m , libreoffice-X-Y, y
libreoffice-X-Y-Z, con las siguientes restricciones:
e Sobre libreoffice-X-Y sélo se solucionan bugs.
e Sobre libreoffice-X-Y-Z sélo se solucionan bugs de bloqueo y traducciones. @

La frecuencia de los merges no esta definida.
;Por qué motivos se crean las ramas?

Con el fin de dividir la funcionalidad ya que hay varias lineas de trabajo.

40


Antonio
Nota adhesiva
Si vais a hacer copia/pega, tenéis que añadir la referencia a a fuente original (además de mantener la consistencia de idioma). 

Antonio
Nota adhesiva
¿Cuál es la relación de la instalación con el código fuente?

Antonio
Nota adhesiva
Un diagrama clarificaría la estructura de repositorios y branches

Antonio
Nota adhesiva
No queda claro el procedimiento de los branches y los merges.

Antonio
Resaltado


:Se hacen ramas especificas para Sistemas Operativos?

No, como hemos visto antes sus ramas estan gestionadas por funcionalidad y luego
durante la construccion al momento de compilar el codigo, se utilizan unos comandos
especificos para determinar el SO.

;Cuando se eliminan las ramas?
Nunca, porque el desarrollo es continuo.

;Qué permisos dan a los usuarios?

Todos los usuarios tienen todos los permisos, commit, pushing pulling, merge, crear un
branch sobre su repositorio, etc. Pero los de niveles mas bajos efectan un pushing se realiza

sobre un repositorio secundario, no el principal.

;Como se hace un commit?

Se puede hacer commits hacia nuestro repositorio en local segln el funcionamiento
habitual de Git; la limitacion de colaboracion esta a la hora de hacer un push con el
repositorio principal o el repositorio de la comunidad. Hay dos repositorios, un repositorio
publico comunitario y un repositorio maestro o gestionado. Solo ciertos usuarios con
privilegios, Committers, pueden hacer push directamente sobre el repositorio maestro. El
resto de usuarios deben hacer un push al publico. Sobre éste se hara una revision de los
cambios realizados por parte de un Committer, vy, si los considera apropiados, los aplicara
sobre el repositorio maestro.

git commit -s --author="'Author name <author@mail.address>'
;Qué patron de comparticion de coédigo se usa?
Se usa un patrén de rama principal. Como hemos dicho anteriormente, LibreOffice

posee 2 repositorios el principal y el publico.

;Como se resuelven los conflictos?
Se pueden presentar los siguientes casos:

e Un documento fue modificado y guardado mientras otro usuario ha abierto el

documento. Si el cambio no entra en conflicto, el documento es guardado, pero si el

cambio entra en conflicto, aparece el dialogo de resolucion de conflictos. El usuario A
debe decidir qué versién guardan para el conflicto. Si mantener la suya o mantener la
que ya estaba. Cuando todos los conflictos estén resueltos, el documento es guardado.

Mientras el usuario A resuelve los conflictos, ninglin otro usuario podra guardar el
documento compartido.

e Siotro usuario intenta guardar el documento compartido y resuelve los conflictos del
momento. El usuario A ve el mensaje que un merge-in esta en progreso, el usuario A
puede optar por cancelar la orden de guardar por ahora o volver a intentar guardarlo

después.
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;Qué herramientas se utilizan?

No se define ninguna herramienta para programar en concreto, permitiendo a los
desarrolladores utilizar la que mas les interese.
Para Git puede utilizarse también cualquier herramienta, pero se recomienda utilizar Gerrit, que
es una interfaz web para utilizarlo.

Ejercicio: Usar Gerrit @

Hemos aprovechado las instrucciones que nos ofrece LibreOffice en su wiki para la instalacion
y configuracion de gerrit para realizar el ejercicio.

Configuracion de Gerrit

1. Siyadispone de un checkout de libreOffice/core, tan sélo tienes que ejecutar ./logerrit
setup, el cual intentard automaticamente instalar las claves y configurar el ssh. Deja la
ventana abierta y no contestes a “Which user name did you choose?”

€« > C [ https://gerritlibreoffice.org/#/q/status:open,n.z ﬁ} 0 =

Zi Aplicaciones Para acceder rapidamente a una pagina, arréstrala a esta barra de Importar hor [ Otros marcadores

Code Review - Register New Account

( IJ OpenD

Register with Gerrit Code Review at gerrit_libreoffice.org

‘ o https:dwww_google com/ /oBfid Reglstev‘ CJosa|

Remember Me
& Register with a Goeogle Account
¥ Register with a Yahoo! ID

What is OpenlID?

OpenlD provides secure single-sign-on, without revealing your passwords to this website.

There are many OpenlD providers available. You may already be member of one!

Get OpenlD
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2. Afade la direccién de correo que usas cuando trabajas con git en las preferencias bajo
“Contact Information”.

Al | My | Projects ‘ Groups | Documentation \lemeOfﬁce Code Review Javier Garcia <jgchroni@gmail.com> | Settings \ Sign Cut
Changes  Drafts = Watched Changes  Starred Changes  Draft Comments SHA-1, trid, gamer.email o mail Searct
Welcome to Gerrit Code Review
Please review your contact information:
The following contact information was automatically obtained when you signed-in to the site. This L
informiation is used to display who you are to others, and to send updates to code reviews you have
either started or subscribed to.
Full Name | Micolas Robayo Moreno
Preferred Emaif | jgchroni@gmail.com |z| Register New Email ...
Save Changes
Select a unique usemame:
Usemame | nicrobmor Select Username
Register an SSH public key:
Gerrit Code Review uses public-key cryptography and SSH to authenticate you during git's push and
pull commands to hosted projects. Registering your public key allows Gerrit to identify you whenever
you connect through SSH.
This step can also be completed at a later fime.
Add SSH Public Key
GitHub's Guide to SSH Keys)
. z1: .z
3. Introduzca un nombre de usuario valido y la clave SSH que le devolvio la ventana de
L C | B https://gerritlibreoffice.org/#/register/q/status:openn,z w0 =
=i Aplicaciones Para acceder rapidamente a una pagina, arréstrala a esta barra de marcadores. Impartar marcadores shora... [ Otros marcadores
Select a unique usemame: 1
Usemame |nicrabmor Select Username
Register an SSH public key:
Gerrit Code Review uses public-key cryptography and SSH to authenticate you during git's push and
pull commands to hosted projecis. Registering your public key allows Gerrit to identify you whenever
you connect through SSH.
This step can also be completed at a later time.
Add SSH Public Key
GitHub's Guide to SSH Keys)
ssh-rsa
AARAB3NzaClyc2EARAADAQABALLBAQDax6C4H+ny6gOUPDEXSAZe 3T OWY JOV S5 rMIMESOTRPRTVEME
ZnZNEJLiIrisREfUTteShORINVECUE1PQHGQCr+3£ 4pHeaCiN3cQT+QBTuraTE] J7Re7 SFm6GUKZRKEX 101
10F5VZR+aCEQYQVEMIpZXebweEMGF1CVT G1uVCOE L Z4NZ0T e dDBkzyrOZne 4PIgTEDAqLHY1YSZTBVVEDD L
76UCn21xscy+y0OniD4NEM4 £ npLacS0aDIYEmiVbdSnYnnptdzT 3TLTRIZ0u/ 1N/ EnyN+ho8me 18 kF S 61w 3
ueq7RpcunnIrBCABr315xUHCO0ky3+nbQIcSe151POL nicofnico-VirtualBox|
)
Clear | Add L
Server Host Key
Fingerprint:
f5:a8:13:af:a0:d8:2d:4b:db:6c:c6:fd:cl:03:b6:87
Entry for ~/ .ssh/known_haosta!
[gerrit.libreoffice.org] :29418 ssh-rsa AAAAB3INZaClyC2EAAAADAQABAAABAQD. . . YDSWOWT11Z [B]
] Y Y = - wa |
. N @ e e
E_/ | > a Q a a ] . LS AR AT e N
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4. Asegurese de que en ${HOME}/.ssh/config aparecen las siguientes secciones (ambas
son idénticas salvo la linea de “Host”):

Host logerrit
IdentityFile /path/to/your/private-key
User YOUR_USERNAME_HERE (cf. above)
Port 29418
HostName gerrit.libreoffice.org

Host gerrit.libreoffice.org
IdentityFile /path/to/your/private-key
User YOUR_USERNAME_HERE (cf. above)
Port 29418
HostName gerrit.libreoffice.org

Terminal & 13 4) 17:06 & Nico {%

pruebaMaven

. ® @ nico@nico-VirtualBox: ~/git/libo
prueba I

Note that you need to register additional email addresses, if you want to
, commit from them. Additional emails must be confirmed with repling to the
#invitation mail it sends you.

entrega entreg
Which user name did you choose? nicrobmor

Please now add the following to your ~/.ssh/config, creating the file if needed:

Host logerrit

IdentityFile ~/.ssh/id_rsa

User nicrobmor

Port 29418

HostName gerrit.libreoffice.org
Host gerrit.libreoffice.org

IdentityFile ~/.ssh/id_rsa

User nicrobmor

Port 29418

HostName gerrit.libreoffice.org

To see if your setup was successful, run './logerrit test' then.
nico@nico-VirtualBox:~/git/1libo$ !

5. Compruebe en que /path/to/your/private-key debe incluir el nombre de fichero también.
Por ejemplo: ~/.ssh/id_rsa.
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6. Para probar la instalacion ejecute run ./logerrit test (en el repositorio de LibreOffice).

Deberia aparecer un mensaje: Your gerrit setup was successful!
- & 1ty 4) 17:10 £ Nico {%

Terminal

pruebaMaven

, ® @ nico@nico-VirtualBox: ~/git/libo

** Message: Error: Esto parece ser un archivo de texto
gstdecodebin2.c(2265): type_found (): /GstPlayBin2:play/GstURIDecodeBin:uridecod
ebin®/GstDecodeBin2:decodebin20:
’ 1decodebin2 cannot decode plain text files
e"UEQGe”U’GQ‘totem-video-thumbnailer couldn't open file 'file:///home/nico/git/1libo/COPYING.M
|PL'
Reason: GstDecodeBin2: Esto parece ser un archivo de texto.
Shutting down nautilus-gdu extension
nico@nico-VirtualBox:~/git/1libo$ cd ..
nico@nico-virtualBox:~/git$ cd ..
nico@nico-VirtualBox:~$ cd .ssh
nico@nico-VirtualBox:~/.ssh$ cd config
bash: cd: config: No es un directorio
nico@nico-VirtualBox:~/.ssh$ cd config
bash: cd: config: No es un directorio
nico@nico-VirtualBox:~/.ssh$S sudo gedit config
nico@nico-virtualBox:~/.ssh$ cd ..
nico@nico-VirtualBox:~$ cd git
nico@nico-VirtualBox:~/git$ cd libo
nico@nico-VirtualBox:~/git/1libo$ ./logerrit test
|[Your gerrit setup was successful!
[nico@nico-VirtualBox:~/git/libo$ I
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7. Prepare su repositorio de git para que pushee a gerrit usando la clave ssh: git config
remote.origin.pushurl ssh://logerrit/core

Terminal 11:07 % Nico %

P

nico@nico-VirtualBox: ~/git/libo
@ nico@nico-VirtualBox:~$ cd git |
nico@nico-vVirtualBox:~/git$ git config remote.origin.pushurl ssh://logerrit/core}
t error: could not lock config file .git/config: No existe el archivo o el directo
rio
J Inico@nico-VvirtualBox:~/git$ cd libo

S ‘nico@nico»virtualBox:~/git/1ibo$ git config remote.origin.pushurl ssh://logerrit
/core
L nico@nico-VirtualBox:~/git/1ibo$ I

S

Fuentes:

http://es.libreoffice.org/caracteristicas/
https://help.libreoffice.org/Common/Collaboration. (@
https://wiki.documentfoundation.org/Git_For_LibreOffice_Developers
https://wiki.documentfoundation.org/Development/gerrit/setup
https://wiki.documentfoundation.org/Development/BuildingOnLinux

100


http://es.libreoffice.org/caracteristicas/
https://help.libreoffice.org/Common/Collaboration
https://wiki.documentfoundation.org/Git_For_LibreOffice_Developers
https://wiki.documentfoundation.org/Development/gerrit/setup
https://wiki.documentfoundation.org/Development/BuildingOnLinux
Antonio
Nota adhesiva
¿Por qué teneis un enlace a editar documentos compartidos en LibreOffice?


Gestion de pruebas

¢Como hace las pruebas LibreOffice o como propone que se podrian hacer ?

LibreOffice deia a libre albedrio de los usuario las distintas pruebas que pueden realizar,
esto es, desde bic por la aplicacién clickando en iconos y botones hasta probar nuevas
caracteristicas.

LibreOffice organiz6 en 2012, para la version Beta 4.0.0, un maratdén de Test que dur6 unos 6
dias.

;Podria proponer u observar qué técnicas de caso de prueba se usan?

Generalmente se basan en la técnica error Guessing basandose en su experiencia,
también usan técnicas de cobertura CRUD, ya que se evalua cada funcionalidad definiendo @
objetivo y los resultados esperados.

Por otra parte, usan las pruebas Smoke Tests, que deben realizarse obligatoriamente 1 6 2

dias antes de liberar una versién. Las pruebas de humo, en espafiol, son las pruebas
preliminares para revelar fallos simples lo suficientemente graves como para rechazar una
version del software prospectivo. Son pruebas simples, como instalar la aplicacion, abrir Writer
y guardar un fichero simple, etcétera.

También se utilizan tests unitarios (automatices) Estos pueden ejecutarse después de construir
el proyecto haciendo un simple make check o@: terminal.

Sin embargo, los tests mas importantes son los tests de regresién (manuales). Pueden hacerse
tests basicos para solventar bugs o tests exhaustivos para versiones importantes. Estos se
realizan mediante MozTrap, que es una aplicacion web que permite probar, generar y mantener
casos de prueba y ver los resultados (dependiendo del rol de la persona).

Ejercicio: Probar casos de prueba usando MozTrap

Para poder probar el software, resulta evidente que tenemos que tenerlo construido en nuestra
maquina. Sin embargo, el uso de la herramienta web MozTrap para casos de prueba funciona
aparte. En este ejercicio nos pondremos en el papel de un usuario ejecutando casos de prueba
e informando de resultados:

11°


Antonio
Nota adhesiva
¿A que os referís con "bichear"?

Antonio
Nota adhesiva
No mezclar las 2 técnicas.

Antonio
Resaltado

Antonio
Resaltado

Antonio
Resaltado

Antonio
Resaltado

Antonio
Nota adhesiva
Resaltar de alguna manera comandos de consola


1. Lo primero que debemos hacer es entrar en la pagina principal de MozTrap
http://manual-test.libreoffice.org/ . Nos aparecera una pantalla tal como la siguiente:

9 MozTrap LibreOffice
View Results §.JuLUTERS Welmm(im[Sig'!In,Reqm!]-

Tast Cases

TEST RUN RESULTS

| Enter filter terms Advanced Filtering »

[»] @ I] moztrap Localization prototypes LibreOffice 1 2012-08-13 None

oA 3.6.2 RC Regression Test LibreOffice 3.6 2012-09-06 None
ola 4.0.0 RC Regression Test LibreOffice 4.0-obsolete 2003-01-1 None
ola I] 4.0.1 RC Regression Test LibreOffice 4.0-obsolete 20130226 None

o(a) 402 RC Regression Test LibreOffice 4.0-obsolete 013-03-21 None (a1 (%1 (-3 ]
ola I] 3.4.6 RC Regression Test LibreOffice 3.6 2013-03-25 None

ola 4,03 R Regression Test LibreOffice 4.0 2013-04-19 None
ola 4.1.x regression test LibreOffice 4.1 2013-09-06 2013-09-21 E
oo E] 420 beta? LibreOffice 4.2.0 2013-12-02 2013-12-15 Y |(%26 (w115 ]
oo i] 402 RCL LibreOffice 4.2.0 2013-12-18 2014-01-05

2. Acto seguido, debemos crearnos una cuenta o iniciar sesion usando OpenID o Persona.

3. Navegamos a Run Tests:

A MozTrap LibreOffice A Install as
PR .\ View Results £ Manage wmm[smm,mud]-

Run Tests LibreOffice 420 4.2 0beta2 x86_64, EN_US, Windows

RUN TESTS:

Regressions tests for the second beta of the 4.2.0 version

“Enter filter terms | Advanced Filtering »

0 @ PENDING Install LibreOffice [ & cerera | % 7t prioy 1 !
[ ( PENDING Create a new Writer document [® o1 || ® wrer | Priority 1 2
[ @ PENDING Spell and grammar checker in your own Lanquage| % pt || % vrieer | Priority 1 3
[ (@ PENDING @ Hyphenation tool [ % p1 |[ % rier | Priority 1 4
[ (O PENDING m Uninstall LibreOffice| % general [ % o1 | Priority 1 3
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4. Seleccionamos el producto, version y conjunto de tests a probar en la nueva pantalla.
Después especificamos algunas propiedades de nuestro sistema y hacemos click en el
botén verde:

Run Tests

TestRuns | Test Cases

LibreQffice i i b

5. Nos apareceran muchos casos de prueba posibles junto con las valoraciones de
usuarios, elegimos uno de los casos para probarlo (en principio elegir al azar facilitaria
gue entre todos los testers se ejecutasen todos los casos)

SET YOUR VALUES TO RUN TESTSIN 4.2.0 BETA2 Archs | xB6_64 |;||
Locale | EN_US [~ |
Platforms. | Windows |;| |
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6. Leemos las instrucciones y pasos del test y lo ejecutamos. Entonces, pueden darse 3

RUN TESTS:

situaciones:

a. Eltest se ha ejecutado correctamente y sin problemas. Entonces deberemos
pinchar en “PASS TEST".

b. Eltest ha fallado. Debemos identificar en qué paso ha fallado y entonces clickear
en el botén “FAIL TEST” correspondiente al paso en concreto y dar un breve
informe de lo que ha ocurrido.

c. Eltestes invalido, no tiene sentido o no estén claros los pasos a realizar:
entonces la accién a realizar es pinchar el boton amarillo, y dar un informe
adecuado.

Regressions tests for the second beta of the 4.2.0 version

&P ‘ Enter filter terms Advanced Filtering »
1 Results Name Suites Order &
PENDING | v | Install LibreOffice | % general || p1 | Priority 1 1
SUBMIT YOURTEST RESULT FOR CASE 228
o PASS TEST | a |
= Thetestis targeting on testing clean installation of LibreOffice build in all supported platforms. Execute platform native installer (requires
root/Administrator privileges) based on your environment:
JFAIL STEP 1. On Solaris — pkgadd
» all of installation goes well. Normal user can execute the application.
. SCFAIL STEP | 2. On Linux—rpm or dpkg
» all of installation goes well. Normal user can execute the application
JFAIL STEP 3. OnWindows — setup_exe
» all of installation goes well. Normal user can execute the application. Make sure the package is signed properly
. SCFAIL STEP | 4. On Mac— open the .dmg file. Drag and drop the executable into the Applications folder.
» If an existing version of LibreOffice is present in Applications folder, you should get a cancel/replace dialog in your native language. If
LibreOffice did not exist there yet, it should be copied to this folder
A orunane A . RSN 1 ) MR DY | | [ -
7. Es posible cambiar de idea, esto es, deshacer la valoracion para incluir otra. Esto se
hace mediante el nuevo icono que aparece en la lista de tests.
RUN TESTS:
Regressions tests for the second beta of the 4.2.0 version
@ ‘ Enter filter terms Advanced Filtaring »
I3 Results Name Suites Order A
| ASSED || ¢||v Install LibreOffice e [wp1) Priy t
PENDING |v | Create anew Writer document % pt [ % wier| Proriy 1 2
PENDING | v \ Spell and grammar checker in your own language| ® p1 [ % urter | Priorfy 1 3
PENDING I x J Hyphenation tool % pt | & writer | Priorfy 1 4
PENDING | v \ Uninstall LibreOffice| & gereral [ % pt | Priority 1 5
PENDING | v \ First Launch of LibreOffice [ general || % 51| Priority 1 6
PENDING | v \ Launch components in different ways | # gera | [ % g | Priority 1 7
PENDING Translation check for installing LibreOffice| & general [ w p1 | Proriy 1 B
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Fuentes:
http://lists.freedesktop.org/archives/libreoffice-ga/2011-August/000020.html
https://wiki.documentfoundation.org/QA/T esting/Subsequenttests
https://wiki.documentfoundation.org/QA/Testing/Regression Tests
https://wiki.documentfoundation.org/MozTrap
https://wiki.documentfoundation.org/MozTrap/User _Guide

Gestion de la construccion

;Qué herramientas se usan ? ; Como se usan esas h mientas ? @

Construir LibreOffice toma tiempo, mucho tid>2Jo. Exactamente cuanto depende de
cémo de rapida sea tu maquina, aungque hay herramientas que puedes usar para acelerar las
cosas.

ccache

Por defecto, ccache se habilitara automéaticamente si se encuentra en tu sistema. Para mejores
resultados, puedes querer incrementar el tamafio de la caché o habilitar la compresién de la
caché; ‘'man ccache’ es tu amigo.

distcc / lcecream

Si estas en un entorno donde tienes acceso a multiples maquinas con ciclos de cpu sobrantes,
puedes echarle un ojo a distcc o icecream, que son herramientas para construccion distribuida.

El soporte para Icecream esta dentro de LibreOffice, es suficiente afiadir --enable-icecream a
Jautogen.sh, y el proceso de configuracion preseleccionara el nimero de trabajos a usar, e
intentara encontrar los icecream gcc wrappers en /opt/icecream/bin. Podrias tenerlos en algin
otro lugar, por favor usa --with-gcc-home=/path/to/your/icecream/bin para sobrescribir eso.

--with-max-jobs / --with-num-cpus

El proceso de construccion puede realizarse ejecutando multiples tareas en paralelo. El
paralelismo total se controla desde el pardmetro de autogen --with-max-jobs y el paralelismo de
cada maquina en subtareas se controla con --with-num-cpus. Si tienes suficiente memoria,
descubrirds que usando --with-max-jobs=n --with-num-cpus=n donde n es tu nimero de
nudcleos, o 2 para --with-max-jobs si solo tienes 1 nucleo, reduce significativamente el tiempo de
construccion.

El comando --with-max-jobs esta por defecto a 1, y --with-num-cpus esta por defecto para el
namero de nucleos/cpus en tu sistema. Nétese que su efecto en red es multiplicativo, ahi
podemos acelerar su producto con procesos de trabajo (compilador) de manera simultanea.

La construccion del proyecto se realiza de forma paralela a la compilacién del mismo. Para ello
se utilizan los siguientes comandos:
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Autogen.sh

Autogen.sh es un script que genera el makefile y configura la construccién segun los
pardmetros que se le pasen. Tiene una gran cantidad de opciones, aunque pueden consultarse
mediante el pardmetro --help

Make

Este makefile descarga las dependencias que queden y realiza la construccién del proyecto,
compildndolo después.

;Qué utilizan y como gestionan las dependencias?

Windows

Windows gestiona sus dependencias mediante cygwin mediante el siguiente comando:

setup.exe -P autoconf,automake,bison,cabextract,flex,gcc-g++[;;1,gnupg,gperf,1ibxm2—
devel, libpngl2-devel,make,mintty,openssh,openssl,patch,perl, pkg-
config,readline,rsync,unzip,vim,wget,zip

Esto lanzara la GUI y te pedira que elijas manualmente las rutas de instalacion etc..., pero los
paquetes pasados por linea de comandos estan preseleccionados lo que significa que sélo
debes aceptar la seleccion.

Debian

Linux las gestiona de una manera mas sencilla usando los siguientes comandos:

sudo apt-get build-dep openoffice.org && sudo apt-get install git libgnomeui-dev gawk
junit4

Ubuntu Natty

Mediante el siguiente comando:

sudo apt-get build-dep libreoffice
Ubuntu Maverick/Lucid
Mediante el siguiente comando:

sudo apt-get build-dep openoffice.org
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Ubuntu Fedora/RedHat

Mediante el siguiente comando:
sudo yum-builddep libreoffice

Mac OS X

Necesita previamente tener instalado XCode con el SDK 10.4 e instalar cada dependencia
mediante comandos, para mas informacion consulta las fuentes mas abajo en esta misma
seccion.

;Cada cuanto tiempo se realiza una construccion del proyecto?

Es variable, depende si la comunidad de desarrolladores dispone de tiempo para
reunirse. Una vez reunidos observaran todos aquellos cambios realizados desde la fecha de la
ltima version en el repositorio maestro y los estudiaran en base a su utilidad en el actual
estado de desarrollo, decidiendo cuéles seran incluidos en la proxima version.

;Los ejecutables estan en control de versiones?
No, no estan en el repositorio. Los ejecutables se generan de manera ajena al control
de versiones.

Ejercicio: compilar y ejecutar LibreOffice en Linux

El proceso de construccion y compilacién de LibreOffice es una operacién costosa. Se
recomienda disponer de mucho tiempo para realizarla y disponer de un equipo capaz, con al
menos 2 GB de RAM, 20 GB de disco duro libres y un procesador del nivel de Intel Core i3.

Para la realizacion de este ejercicio, se ha hecho uso de una Maquina Virtual donde se ha
instalado una version limpia de Ubuntu v12.04.

Utilizando 2 ndcleos de uni7, 2 GB de RAM, 30 GB de disco duro asignados a la MV y a una
velocidad de descarga media de 500 KiB/s (con una conexion de unos 15 MB de ancho de
banda aproximadamente), se han tardado 5-6 horas en tener LibreOffice preparado.

1. Descargar codigo fuente

Lo primero a realizar es descargar las dependencias. Pueden utilizarse los siguientes
comandos de terminal:

sudo apt-get build-dep libreoffice # on Debian/Ubuntu
sudo zypper si -d libreoffice # on OpenSUSE 11.4 or later

sudo yum-builddep libreoffice # only on Fedora 15+ & derivatives
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Una vez estén descargadas, es hora de descargar el codigo fuente en si. Puede descargarse
clonando el repositorio de git:

mkdir git

cd git

git clone git://anongit.freedesktop.org/libreoffice/core libreoffice
Esto clonaria el repositorio en una nueva carpeta llamada libreoffice.

El repositorio de LibreOffice es muy lento. Con el objeto de este trabajo hemos preparado un
nuevo repositorio en BitBucket. El repositorio esta localizado en la siguiente direccion:
https://bitbucket.org/jesrivcap/libreoffice.git

2. Compilar el cadigo fuente
En la carpeta donde esté el repositorio de git, ejecutar
cd libreoffice
./autogen.sh
Este comando genera el makefile para compilar LibreOffice
make
Ejecutamos el makefile anteriormente creado, construyendo y compilando el proyecto.
3. Montar el entorno de desarrollo
Para arrancar LibreOffice es necesario lanzar el siguiente comando:
make debugrun

En ese momento el programa solicitar4 un comando adicional (se puede reconocer porque la
linea de comando empieza por (gdb)). Aqui selecionamos la aplicacion concreta de LibreOffice
gue gueremos ejecutar. Por ejemplo, podemos arrancar Writer:

run --writer

Notese que se incluyen dos ‘-’. En el caso de utilizar uno tratara de arrancar una version de
Writer vieja, la cual dara un error.

Si todo ha ido bien, Writer entrara en ejecucion, mostrando su interfaz gréfica.
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https://wiki.documentfoundation.org/Development/Windows Build Dependencies/es
https://wiki.documentfoundation.org/Development/Native Build/es
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Integracion/despliegue continuos

¢, Qué tipo de Integracion utilizan: Big Bang o Incremental?

Hemos hecho una investigacion donde se ha preguntado a algunos desarrolladores si
desarrollaban sobre una integracién continua, obteniendo c= respuesta que no automatizan
su integracion. LibreOffice posee demasiado cédigo fuente ,CR tiempo de compilacion ronda
por las 4-5 horas, asi que proponemos el uso de una herramienta para automatizar esto y que
al momento de trabajar se pueda coger directamente el cédigo compilado y ahorrar tiempo ello.
A continuaciéon mostramos las imagenes de la conversacion:

& 5 C i [)wwwlibreofficeorg/get-help/irc-help/ Q@ @]@' ¥ Ikl
=5 Anlicaciones Q)G\t @ Manual de C tutorial.. DBqumg LibreOffice .., E‘ﬂ SAGE (1 ETSI [ UsaL [=] sirmyo - Misimyo, L. ] Binary Search Trees W], Diccionarios de Espa.. » [ Otros marcadc
[17:24] <loircbot> Libreoffice (core) mstahl * forms/source/component/formcontrolfont.cxx: g;z\e% @
FontControliodel: :convertFastPropertyvalue: fix bad cast of Kerning @Fridrich
[17:24] <loircbot> Libreoffice (core) mstahl * forms/source/ (5 files in 3 dirs): forms: avoid @ijcorrius
deadlock when setting FontControlvodel properties {@kendy
[17:24] <mst_ > sberg, #** the horrible fix {@kohei
[17:24] <@shm_get> jesrivcap-us-es so that is your subject matter right ? so you should know better = @mmeeks
than us how to do that no ? - @mogg
[17:24] == cpaul [~cpaul@7@.228.120.144] has quit [Remote host closed the connection] g;?ﬁ‘apdek

[17:24] == cpaul [~cpaul@7e.228.120.144] has joined #libreoffice-dev

[17:25] == mitch_[~mitch@p5DDEBABZ. dipd.t-ipconnect.de] has joined ¢libreoffice-dev @reliele

- <. . . @shm_get
[17:25] == mode/#1libreoffice-dev [+o _mitch_] by Chansery @Sweetshark
[17:26] <loircboty Libre0ffice (core) [libreoffice-4-2] mstahl * @thorsten
forms/source/component/formcontrolfont.cxx: FontControlvodel: :convertfastPropertyvalue: fix bad @vmiklos
cast of Kerning ahdulaziz

[17:261 <loircbot> Libreoffice (core) [libreoffice-4-21 mstahl * forms/source/ (5 files in 3 dirs): ~adam co <
Don't you use a jenkins or similar software?

Other Channels

There are other IRC channels reserved for LibreOffice. If you want to connact to them just go to the "Status" and type “fjoin channelname”

replacing channelname with the name of the channel you need. Some of these channels are:

N #libreoffice-dev: Development Channel

N #df-infra; Related to all TDF-hosted websites and infrastructures
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Como herramienta para integracion continua, en principio proponemos el uso de Jenkins, sin
embargo, durante las pruebas realizadas para estudiar su utilizacién nos hemos encontrado
con obstaculos insalvables que han impedido su uso. Entre ellos:

e Timeout de 10 minutos en el plugin Git de Jenkins, no configurable, que impide hacer un
checkout de LibreOffice desde un repositorio externo (ya sea el propio de la comunidad,
0 cualquier otro que se cree con objeto de este trabajo) o incluso en local, debido al
gran tamafo. Como fuente para este problema consultese la siguiente direccion:
https://issues.jenkins-ci.org/browse/JENKINS-20387

e Incapacidad de LibreOffice de realizar ejecutar el makefile desde Jenkins
correctamente, ya que, de algin modo, no es capaz de realizar peticiones web para
recoger las dependencias necesarias.

e No es posible realizar la integraciéon con ningun servidor Git y Jenkins debido a que el
Jenkins que utilizamos es local. Hacer esto posible requeriria modificar la configuracion
del router local para redireccionar el trafico. Esta posibilidad se observa con el servicio
de Bitbucket, pero no disponemaos de infrastructura suficiente como para enlazar el sitio
gue ofrece el servicio a nuestro equipo a través de nuestro router y un servicio de
direccion estatica.

e Jenkins esta muy orientado a proyectos escritos en Java y sus plataformas. Esto hace
dificil adaptarlo a este proyecto, escrito en C++,

e Hemos encontrado dificultades para usar los plugins de Jenkins, creemos que por
desconocimiento de cémo configurarlos (advertimos fallas de documentacion en los
mismos) o por falta de soporte especifico.

Por tanto, consideramos que no es la plataforma de integracion mas recomendada para este
proyecto. El tiempo de realizacién de este trabajo impide realizar nuevas basquedas, sin
embargo, no descartamos que otras herramientas puedan funcionar adecuadamente para su
uso con LibreOffice.

Gestion de entregables

Los entregables de Libreoffice son basicamente los fi@os binarios que distribuye con todos
los componentes, los cuales se colocan en la pagina web de LibreOffice para su acceso
publico.

Gestion del despliegue e

LibreOffice, como aplicacién de escritorio que es, ofrece binarios para cada posible plataforma
gue los usuarios pueden utilizar para instalarlo en sus maquinas.
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Gestion de incidencias y depuracion

Si trabajamos con Ubuntu

Para reportar un problema especifico a Ubuntu, primero verifique si no se encuentra en
la lista actualizada, luego llene éste formulario y especifiq breoffice bajo In what package
did you find this bug?. Recuerde agregar el "tag" 033 a su reporte.

También es Util reportar el mismo problema en FreeDesktop.org como se indica ante@nente
pues dichos reportes "upstream" pueden ser verificados (y posiblemente probados y
arreglados) en otras versiones de LibreOffice.

¢Quién y como se priorizan las incidencias?
Las incidencias las resuelven los desarrolladores como a ellos mejor les parezca,
tomando como criterios la prioridad del fallo y su propia experiencia.

;Como se encaja esto con la gestion del codigo?

Cada minor de una version incorpora las correcciones que se detectan en las
incidencias, pero solamente en las versiones que incrementan el major, se incluyen nuevas
funcionalidades. Cada una de estas versiones se orgn en un fork en git, generandose uno
por cada versidn que se obtiene.

;Cuando y como vamos a liberar versiones?

No se tiene una fecha en concreto para realizar una liberacion de una version, cuando
una version es estable siempre tiene que tener el formato: x.y. Los compilados que contienen
cambios de la X son aquellos que incluyen nuevas funcionalidades, y los que incluyen cambios
en la Y, son los que incluyen revisiones de fallos, pero no afiaden funcionalidad.

;Como vamos a gestionar los cambios?

Hasta el momento, solamente 60 personas deciden los cambios, siendo este un sistema
muy centralizado. De este modo proponemos un sistema mas colaborativo en cuanto a la toma
de decisiones, de forma que los usuarios puedan aportar y valorar ideas y se aprueben por
votacién, decidiéndose a su vez la prioridad de las mismas.

;Como se informa de una incidencia?
LibreOffice utiliza Bugzilla para gestionar los informes de incidencias.

;Como se informa de un bug?; hay plantillas?

Mediante correo electronico o por la herramienta Bugzilla antes mencionada,
lamentablemente no usan plantillas predefinidas al realizar un reporte, esto ayudaria mucho
para poder sintetizar y poder hacer el seguimiento facilmente.
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;Como se gestiona el reporte de bug?
Para el reporte de bugs LibreOffice utiliza Bugzilla y listas de correo. LibreOffice ofrece
una interfaz en su web donde debes seguir los siguientes pasos:

Sign in : nos pide las credenciales de la cuenta de Bugzilla.

Component : tipo del bug.

Details : tipo del componente. (subtipo del bug)

Description : en qué consiste el bug.

Submit : enviamos el reporte para que se afiada a la base de datos de Bugzilla.

Si Bugzilla no te gusta, puedes utilizar las listas de correo que ofrece LibreOffice para
reporte de bug users@global.libreoffice.org 0 en todo caso el foro LibreOfficeForum.org.

Ejercicio: Enviar un bug en LibreOffice

Entramos en Bug Submission Assistant, necesitaremos habernos hecho una cuenta de
Bugzilla. Para crearla entra aqui https://bugs.freedesktop.org/createaccount.cgi.

1: Iniciar sesidn
Utiliza la cuenta de Bugzilla.

2: Componente

En el combobox de Componente, elegimos el componente que queramos reportar.Si no estas
seguro de que componente se adecua a tu problema elige el componente LibreOffice y luego
los usuarios con mayor experiencia cambiaran esta opcién a la adecuada.

D LibI"EO'Fﬁce The free office suite

The Document Foundation

Home: Download Features Get Help Get Involved Developers International Sites About Us Security

Mabble Mailing Lists Installation Drocumentation Accessibility Bug Ask LibreOffice Online Help IRC

Bug
Bug Thank you for using LibreOffice and for helping us improve our software. This
= = assistant will lead you step-by-step through the bug-reporting process. Please
Submission submit a separate bug for each issue!
Assistant For our full-featured bugtracker go to
o Sign in Component. | (Choose one) -
) Te=1TTila -
=E=‘ Drawing Component Libreoffice
Component E=\) |EE | Extensions 7
| Form a Editor If you cantfind any other appropriate
- - . component:
\-‘ __ S| Installation MIiNGW for problems with the MinGW
- == A builds from Tinderbox @7 Master and
e Details mm |ibreoffice daily Branch,
o || LiNguistic 11 for all other i
w [~ Localization [11for all ather issues
o Description ]E[ Presentation i Read more . >
© submit
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3: Detalles
Ahora seleccionaremos un “Sub componente” en la seccion correspondiente.

Si no sabes el subcomponente apropiado ve a Componentes. En esa pagina, clickea el
componente apropiado.

Components

¢ Android Impress Remote, the LibreOffice Impress Remote app for Android
BASIC, programming using the Basic languags

Chart, data charts and plots

ci-infra, internal feature request for the tinderbox/gerrit infrastructure

contrib, to be used if you want to contribute tools, templates, or something similar to LibreOffice
Database. the database application LibreOffice Base
deletionrequest, for bugs which have been created only for testing Bugzilla or the Bug Submission Assistant

Documentation, for problems with LibreOffice user guides €, localized Help packages, and LibreOffice Help &

Drawing. the drawing application LibreOffice Draw

Extensions, for some specific problems with extensions: but not for the extensions website, which uses the component VWWW

filters and storage, import and export code, and /O infrastructure shared between applications; mostly interesting for developers

Formula Editor, the formula editor, which is probably LibreCffice Math

framework, the application framework &, ie. code shared between applications not part of the graphical toolkit pieces

graphics stack, the VCL toolkit, drawing layer, and all non-print specific rendering functionality, interesting for developers

Installation, for problems with installing LibreOffice

Libreoffice. to be used if you can't find any other appropriate component

Linguistic, for problems with spell check. right-to-left, hyphenation, or the thesaurus, not specific to one language

Localization, for all problems that are related to a particular language version of LibreOffice. Alternatively you can use one of the other components and set the [10n subcomponent.
Presentation, the presentation application LibreOffice Impress

Printing and PDF export, for general problems with Printing or PDF export that are not limited to a single application (like WRITER or CALC)

sdk, the UNO runtime emvironment, UNO AP| and SDK. interesting for developers

Spreadshest, the spreadsheet application LibreOffice Calc

UL for problems concemning User Inteface. You should also use this component if your problem affects more than 1 Application or if you can't decide what the correct component might be.
ux-advise, to be used only by QA staff or developers

Writer, the word processor LibreOffice Writer

o WY, for problems concemning website (bad links, for example), Bug-Tracker, software downloads, not responding or incomplete mirrors, mailing lists. ...

Lee las descripciones de todos los subcomponentes de la pagina de ese componente.

Sub-components

Some Sub-components are specific to a particular Component. In that case, theyl be listed under their parent Component. For example ASKLIBREOFFICE is listed under WV,

All other sub-components are described herel

How to use subcomponents

On BugReport Details lots of subcomponents are listed with links to Bugzilla Search and Bugzilla bug submission. In the following you find hints for what kind of problems what Subcomponents
should be used in the Bugzilla Subject line. In the following listing a click on the Sub Component heading will start a Bugzilla query for that sub component.

CONFIGURATION
Use for instance, if the configuration of LibreOffice applications (WRITER, DRAW. CALC, ...} is broken or if the Installation associates file extensions wrongly.
FILEOPEN

For all problems related to opening documents, as well as for problems when opening non-ODF file types like MS-Office, XHTML or XML, Picture formats like PNG, SVG, WMF, .. . Please
generally mention the document type and if known and appropriate the Version of the document or of the software with what it has been created in parenthesis. Examples &:

+ CRASH when FILEOPEN particular XLSX (MS02007)
» FILEOPEN particular CDR (X6} shows

FILESAVE

For all problems related to saving documents, as well as for problems when exporting to the file types XHTML or XML and Picture formats like PNG, SWVG, WMF, ..
MAILMERGE

For problems with the LibreOffice Mailmerge function from menu Tools -= Mail Merge Wizard' or with the Form Letter function in menu ‘File == Print’.

MinGW

MinGW & (Minimalist GMU for Windows) is a free toolchain based on GCC (the GMU Compiler Collection). So far we are using the Microsoft VisualStudie C++ compiler to provide the Windows
builds, but the intent is to switch to MinGW to produce the Windows binaries. At the current stage. the MinGW builds start, and are somewhat usable. but contain bugs, and need testing.

Bugs should be marked with MinGW only when they appear in the builds from here &, but not in other Windows, or Linux builds.

Please note that MinGW builds are binary incompatible with the MSVC &, which means that extensions written in C++ built with MSVC cannot work in MinGW builds.

PDF
For PDF export problems only visible in one compaonent like Drawing, Presentation, Spreadsheet or Writer. In DRAW together with FILEOPEN for PDF import problems.
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Si no ves el subcomponente adecuado, clickea en Extended Help, y lee las descripciones de
los subcomponentes en esa pagina. Una vez que sepas cudl es el subcomponente que buscas,
seleccidnalo en el Bug Submission Assistant. Si no puedes descubrir qué subcomponente
tienes que usar, selecciona “(All other problems)” en el Bug Submission Assistant.

Escoge la version de la aplicacion donde aparecié el bug. Para comprobarlo en LibreOffice,
selecciona Help > About >LibreOffice

En “Operating system” o “OS”, escoge tu sistema operativo.
Si hay una seccion de “Hardware”, rellénala.

Si hay una seccion “Severity”, ignéra esta seccion sino tienes experiencia. Seleccionando
“Blocker” no hara que el bug se solucidne mas rapido. Si quieres saber las definiciones de los
items en la seccion Severity, échale un ojo a su carta.

También, puedes ignorar la seccion “latest known-working version”.

Home Download Features Get Help Get Involved Developers International Sites About Us Security

Nabble Mailing Lists Installation Documentation Accessibility Bug Ask LibreOffice Online Help IRC

Bug Thank you for using LibreOffice and for helping us improve our software. This
P assistant will lead you step-by-step through the bug-reporting process. Please

Sl.lb-n'IISSIOI'I submit a separate bug for each issue!

Assistant For our full-featured bugtracker go to

o Sign in Component:  Libreoffice .
N N N Component Libreoffice
| |l

=l
© component = _
Ifyou cantfind any other appropriate
component:

\.‘ N[N MinGW for problems with the MinGW
- builds from Tinderbox @7 Master and
o Details ' daily Branch,

N N N S N N\ [1for all otherissues.
o Description | @I . | I Read more ... »

Sub component: Version the bug appeared:
o Submit (Choose one) . 4.1.3.2 release .
Operating system: Latest known-working version:

Windows 7 B o lv|
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4: Descripcion
En la seccion “Subject” :

e No incluya informacion ya conocida de los campos anteriores.

e Sino estas usando el Bug Submission Assistant: Incluye los nombres de los
subcomponentes de los Componentes.(Si estads usando este asistente, la seccion
“Subcomponente” es el lugar para incluir los subcomponentes).

o Pon mayusculas en los subcomponentes.

o El subcomponente puede ser confundido con partes de una palabra( por
ejemplo, Ul es parte de la palabra quit), por lo que te recomendamos que rodees
los subcomponentes con corchetes.

o Usa al menos 2 subcomponentes.

e Resume el problema con la maxima precision.
o Un resumen incorrecto: “El fichero esta roto”.
o Un resumen mas adecuado: El menu File > Save as no esta disponible (esta en

gris).

e Evita las formas cortas como “doesn’t” or “isn’t” (para el inglés) para relajar los strings
en el Sumario; en vez de eso, usa la forma completa como “does not” or “is not”.

e Si el problema escrito en el reporte es que LibreOffice se crashea o para de
responder(se cuelga), agrega la palabra CRASH al sumario, asi esos bugs pueden
resolverse mas facil.

En la seccion “Long Description” o “Description”, hay que dar una descripcién de los hechos
mas larga.

En esta misma seccién, hay que dar una lista de pasos para reproducir el bug.

e Usar una lista enumerada.

e Declarar el método exacto que hizo que ocurriera el bug. Por ejemplo, en vez de escribir
“Abrir documento”, escribir “En nuevo documento vacio LibO Spreadsheet”, usa menu
File > Abrir (didlogo LibO) > archivo tipo “Documento de texto” > seleccionar el
documento de muestra adjunto > doble click”.
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Si estas usando una pre-construccion de LibreOffice bajo Linux, declara la version exacta de
los paquetes de LibreOffice de tu sistema de gestion de paquetes.

e Incluir informacion sobre donde lo instalaste y la localizacién (Ul idioma, documentos
de idioma) podria ser (til.

e Incluir si se estd usando un LibreOffice de 32 bits en una sistema de 64 bits.

e Incluir si el paquete es una construccién no oficial de LibreOffice.

Escribe el comportamiento esperado y el comportamiento actual.

Puedes incluir un adjunto, como una screenshot o un documento de ejemplo.

e Sicreas unas screenshots, cambia el idioma a inglés antes de hacerla. Para ello
dirigete a Tools » Options » Language Settings » Languages.

e Puedes hacer screenshots mas Utiles afiadiendo comentarios y marcando las areas
relevantes con Draw de LibreOffice.

e Siquieres juntar mas de una screenshot, deberias recopilar todas ellas en un
documento y adjuntarlo como PDF. Por favor afiadir un comentario breve por cada
screenshot para decir lo que quieres demostrar con ella.

e Siquieres unir mas de un documento, deberias crear un archivo .zip conteniendo todos
los documentos y un adjuntar eso como .zip.

e Situ adjunto es demasiado grande como para almacenarlo en Bugzilla (mayor de 1 MB)
puedes usar la Pagina Experimental de Subida.

5: Envio

Clicka en “Submit” y tu reporte sera agregado a la base de datos de Bugzilla.

Si Bugzilla te parece desalentador

Si el sistema del bug tracking de Bugzilla parece desalentador o muy dificil de comprender, deberias
postear tu problema aqui: users@global.libreoffice.org user support list o LibreOfficeForum.org.
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Gestion de la variabilidad

Tomamos como ejercicio la instalacion de LibreOffice, la que nos ofrece los distintos productos
de variabilidad (VP): Mddulos de Programa, ldiomas Adicionales para Interfaz de Usuario y
Componentes Opcionales, que €stos a su vez tienen distintos niveles, de los cuales los
representamos mediante los siguientes diagramas:

Méoédulos de
programa

Writer

Impress

Idiomas adicionales
para interfaz de
usuario

\') V' \') \" V'
Afrikaans Amarico Arabe Asamés Asturiano
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Componentes
Opcionales

[0..11]
A\ v \" v \")
s Filtro de Actualizaciones o . Generador
Diccinarios Imagen en linea Inicio Rapido de Informes

Aragonés Portugués Cataldn Francés Gallego

v v v
Seript para tinimizador dol ;I’_g'g'-'rca-n_lpaﬂélﬂdn Publicacién Seript
Beanshell no lineal Mediavyiki JavaScript
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Mapa de herramientas
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Conclusiones

LibreOffice es un proyecto colaborativo en el que participa mucha gente, pero tiene un proceso
centralizado en el que pocas personas gestionan los cambios. Mucha gente realiza cambios
pero so6lo unos pocos que se seleccionan llegan a aprobarse e integrarse. Sus procesos tanto
de pruebas como de integracion son mayoritariamente manuales, y estos procesos estan bien
asentados debido a la gran cantidad de contribuyentes. Afladiendo esto a la inherente
dificultad, siendo un proyecto de gran envergadura, de implementar estos procesos, no
esperamos que vayan a cambiar.

Su despliegue y entrega son simples: colocar ficheros de instalacién con todo lo necesario en la
pagina web de LibreOffice. Esto es debido a que es fundamentalmente una aplicacion de
escritorio.

Un detalle interesante es la carencia de herramientas estandarizadas en la mayoria de areas,
principalmente MozTrap y Git son las de uso obligatorio. No se considera un entorno de
desarrollo estandar, ni tampoco la interfaz de Git, e incluso no se llega a usar una Unica
herramienta para el reporte de incidencias, debido al caracter libre y fuertemente colaborativo
de la aplicacion.

Una gran acierto al desarrollar la aplicacion es el sistem@ plugins. De este modo puede
beneficiarse enormemente de los aportes de la comunidad, existiendo infinidad de ellos que
cubren muchas funcionalidades sin explorar, idiomas nuevos, y mas.

LibreOffice tiene una gestion de la configuracioén asentada y eficaz, pero creemos que mejorar
la organizacion y la toma de decisiones haria mucho bien por su desarrollo. Sinca=bargo,
hemos de tener en cuenta que para un proyecto de software libre, es una autén odisea
solventar estos aspectos.
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